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The Sales and Services Tax (SST) has been implemented in Malaysia. The SST replaces the existing Goods and
Services Tax (GST) and affects all domestic and import shipments.

The SST has two elements:

A Service Tax that is charged and levied on taxable services provided by any taxable person in Malaysia in the
course and furtherance of business,

and a single stage Sales Tax levied on imported and locally manufactured goods, either at the time of

importation or at the time the goods are sold or otherwise disposed of by the manufacturer.

SETTING UP

1. Files > Modules
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2. Tick GST/VAT/SST. Save & Close

o} Module Manager

Modules & Features

|7_ General Ledger

|7_ Account Receivable
|7_ Account Payable
[v] Stocks

|7_ Sales

|7_ Purchases

|7_ MultiLocation

|7_ Multi-Currency

[v] Project

/] gsTpvaT/ssT |

| Partial Delivery

|—_ Manufacturing

|—. Price Group

[+] Audit Trail

|__ Report Suite

|—_ Cost Centre

|—_ Serial Mumber
[Jros

|7_ Validation Manager
|—_ Points Management
|—_ User Defined Fields
|7_ GST Margin Scheme

|7_ GST Group Registration
l__ Finance Charge

,7_ Deposit

|7_ Advance Currency

|7_ Layout Customization
[ Batch Email Distribution
l__ Landing Cost

|—_ Packing Lists

|—_ WTax

l__ Stock Commission Group
l__ Batch Mumber

|—_ Starter Pack Plus

|—. Starter Pack

l__ Free Edition

l__ Itemized Project Knock-Off
|—_ User Default Setting

l__ Partial Exemption

l__ Recurring

|—_ Progress Inveicing

|—_ Biling Approvals Control
l__ Customer | Supplier Item
l__ Stock Take

|7_ Cash Register Integration
|—_ Maybank2e

|—_ Credit Control

[] QNE BizPay

[] oNE BizPay Plus

|—_ E-Commerce

|—_ Apply Pricing Rule

[] packing UOM

|—_ Property Management

|—_ Post as Accrued AP

[ Meter Biling

|—_ Advance Manufacturing
|—. Cash Flow Forecast Advisor
|—_ Finished Goods Produce

|__ Fixed Commission Rates

|—_ Renewal System

|—_ Packing UOM Summary

|—_ Consolidated Finandial Reports
|—_ Stock Sub-Code

= O
+ Tasks

E Apply Changes
Eﬂ Save & Close

ﬂ Close

3. Go to GST/SST Settings. Enter Date. Tick SST Registrant. Save

.

General Settings

Taxable Period Category
Effective Date

Filing Due Date
De-registration Date

Default Tax Code By Period | Preset Accounts | Free Gift [ Partial Exemption | Adjustment l Exempt Supplies | Transactions' Tax Inclusive | Bank Charges | Options

o & ﬁ -2
Input Tax

a X 8]

Effective Date From

Effective Date To

20¢ GST/SST Settings

2 Months
01/01/2021
31/03/2021

&3 View Variants~

SST Options

®){$ST Redistrant!

Output Tax

Fre

Non SST Registrant

e Gift

Bank Charges
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4. Upon saving, Tax Code Update will show

Please select ‘Sales’ or ‘Services’ depends on what your company is registered under. Click OK

If the SST tax codes are not yet defined, you are required to create it; please define below tax rate:
Sales/Purchase Tax Rate 0.00%

Service Tax Rate 0.00%

Is your business related to sales or services?

h Services

o' GST - Tax Code Items

Effective from 01 September 2018, the government of Malaysia will reintroduce Sales and Services Tax (SST). As a result, you have an
option to set below previously used Tax Codes for GST as Inactive/Active. Please tick the checkbox to set the tax as Active or untick the
checkbox to set the tax as Inactive.

B & & ViewVariants @ @ & g - 2

Tax # - | Tax Type Description Rate Input/Output Tax

5. Go to GST/SST Accounts Setup. Click Apply. The purpose for this step is creating the GL Account under
Chart of Account and assigned in Tax Code Posting (You can refer the result in step 6 and 7)

38 GST/SST Accounts Setup
GST Accounts
L 2 BviewvVaians- | @ @ | [@ - 8
| create ~ [GLaccount [ Account Code [ Account Name oot Code. TR
» ’T SST-1000 S5T-1000 SST SALES TAX
’T S5T-2000 S5T-2000 SS5T SERVICE TAX |GmmEms
’? S5T-5000 55T-5000 SS5T DEFERRED TAX Assign GST Accounts
[m] S5T-3000 S5T-3000 S5T PURCHASE TAX L = View Variants~ | @ & @ - @
=] 35T-4000 55T-4000 ST EXPENSES SERVI.. [Name  [Description GLAccount Current
’T SST-6000 SST-6000 SST FROM SUPPLIER. } |~ TaxCodes
’T S5T-8000 S5T-8000 SST PAYABLE ACCOU... ST-10% Sales Tax (S5T) =5T-1000 S5T-1000
’? S5T-9000 55T-9000 S5T OUTSTANDING 5. ST-5% Sales Tax (S5T) S5T-1000 S5T-1000
ST-DA Sales Tax(Designated Area) 55T-1000 S5T-1000
ST-EP Sales Tax(Export) 55T-1000 S5T-1000
ST-GEX Sales Tax(Goods Exempted From Tax) S5T-1000 S5T-1000
STPA Sales Tax(Persons Exempted From Payment Of T... SST-1000 S5T-1000
ST-PB Sales Tax({Persons Exempted From Payment Of T...  SST-1000 SS5T-1000
ST-PC1 Sales Tax(Persons Exempted From Payment OF T_..| 55T-1000 S5T-1000
ST-PC2 Sales Tax(Persons Exempted From Payment Of T...  S5T-1000 S5T-1000
STPC3 Sales Tax(Persons Exempted From Payment Of T_..| SST-1000 S5T-1000
STPC4 Sales Tax(Persons Exempted From Payment Of T... SST-1000 S5T-1000
ST-PCS Sales Tax({Persons Exempted From Payment Of T...  SST-1000 SS5T-1000
ST-5A Sales Tax(Spedal Area) 55T-1000 S5T-1000
STU-10% Sales Tax (S5T) — Goods For Own Used/Disposed | S5T-1000 S5T-1000
STU-5% Sales Tax (SST) — Goods For Own Used/Disposed | 55T-1000 S5T-1000

DocNo :1 Page No: 4/19
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6. Go to General Ledger > Chart of Accounts.

Type and search SST. Notice that SST GL account codes have been applied

sst Find Clear
Description Account Code MSIC Code SA Currency
» |~ £ LESS: COST OF SALES i CoG
.|| 85T PURCHASE TAX 85T-3000 RM
w 4_-‘1' LESS: EXPEMSES EXP
. || 85T EXPEMNSES SERVICE TAX B5T-4000 RM
~ 4_: CURRENT ASSETS BCA
. || 851 FROM SUPPLIER. DEPOSIT SST-6000 RM
. || 88T OUTSTANDING SERVICE TAX S5T-9000 RM
w 4_-'7 CURRENT LIABILITIES BCL
. || 88T SALES TAX S5T-1000 RM
. || BST SERVICE TAX B5T-2000 RM
. || 85T DEFERRED TAX 85T-5000 RM
. || 88T PAYABLE ACCOUNT SS5T-3000 RM
7. Go to Tax Codes. GL account is applicable in Posting Account column now.
System will post to the GL account according to the tax code as defined.
d
%' Tax Codes
Tax Codes
Tax # ST-10%
Tax Type Standard-rated
Input/Output Tax Qutput Tax Rate 10.00%:
Tax Description Sales Tax (35T)
Posting Account S5T-1000: 55T SALES TAX B
Deferred VAT Posting Account -
+| Default | Active
Sales Tax (S5T)
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8. Go to File > Company Profile

> Migration Assistant

@ About...

D —
o=—Change Log

a—
Company Profile
Help

Maodules
Registration

Web Portal

Log Off

Gl oE.oR Ul iy ST o

Exit

Fault
W

[E

e

Window
List «

Windows

Company Profile

=] Al

Panels  Font
W

Actions

Update Sales Tax Register Number if you are register under Sales Tax
Update Services Tax Register Number if you are register under Service Tax

«% Company Profile

Company Name [TESTINGDB_2021.0.0.3

Reg No. 1234567 GST Reg HNo.

ST Abpronal - | PBT / Margin Scheme No. |
| sales Tax Reg No. | ooooos765433

| service Tax Reg No. |

Dem'ﬁs.] Logo ] Comﬁany Info I Preview l Joﬁi’av }

Address 1
Address 2
Address 3
Address 4
Zip Code

Phone 1 |09-65432165 '~ Phone 2
Fax 1 | Fax2
Contact Person |Lee

Email |support@qne.com.my

Home Page |
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9. Go to Company Info. Update SST Register Number under company letter head

Sales Tax Reg No. [000098765433 Service Tax Reg No. \
| Details I Logo Prev-ew'[ JomPay-l
[Reset to Default |
: [Tahoma e <J]A-%-B I UUS S X X ChongeCase A A B A -5 -
@9 ®-:F -:=E|=E|= = LineSpacing~ §= = = =& i ¥ BD-:HB-:Q- e 5B
i@ - i E v - Selectr [ ©7 - i Margins~ Orientation~ |}~ Columns~® Breaks~ Line Numbers> ~ : 8 = & 8 - Bordersy v i |—— | ~
g .|...|...g..‘|...|...q.‘.z.'.|...3...|...‘...q...5....A..5...|.a.1.. t
: v v i i > 2 : X T ¥ x x , B
'él
-] TE! 1567)
No. 1, Jalan 2, Kawasan Peringusirian 1193, 43000 Kajang
Tal + NO-ASA221A5 -

SST SALES TAX

1. Go to Stock Item > Default GST/SST.

() Stock Items

Stock Item
Stock # |RM2 [v] Stock Control | Active Defaulttocation |
Stock Name |RAW MATERIAL 2 Cataocry [
2 Group w
! ctass |
Created Date | 14/10/2021 - Preset Code  |general

, Details I Mult-UOMs I Stock Control[ Serial Nol Batch NoI Default GST/SST I Sub-CodeJ Stock Bundle [@. Customer Price l Picture 1 Note ] (") Files I Others ‘

Input Tax ’

| output Tax |

SST Tariff Code | N

]
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2. Create SST Tariff Code for your item

S 1 N | Reload

¥

L‘ StOCk | Taniff Code ‘Neil -

Stock Tiem » 10000.11.9999

Stock # |RM2

Stock Name RA\:

Created Date | 1/

Details | Mult-UOM:

Input Tax

ssrran'ffCodei

3. Define Tariff Code accordingly. Save & Close the tariff code and stock item after defined.

18- Home Edit Task
[ @& & ©
New
v Close v Tral
Records Creation Save

%' Tariff Codes

Tariff Code | 0000.22.8888

f2d

=B

Settings v Record

View

Records Navigation

© @ @

Save Save and Save and New  Audit Reset View View Variants Previous Next Record Search  Close

Close

[v] Active

Description |0000.22.888¢
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4. Create Cash Sales. Insert Tax field by right click the title row and select Column Chooser

87 Cash Sales

Details |Cusbon1er | DO Address | Others | Notes | ("] Files | Info | JomPay |

Cust | v| Currency

To | | Attention
Term [c.oo. -| Agent
Location | v| Deposit To
Bank Charges |0.00 | Reference No.

MYR.

CASH IN HAND

Rate
| DocDate  [14/10/2021 |
“| Csaleswo. [csoooos |
.
| [IPostToAR [ | Tay

Details | Multi-Payments

il | Scan Item..

OFEER

| -f_'_"|5tock Code |Descripﬁ0n |

Qty

y
|uor~f|

B o

|Unit Fr... |Disc

J View Variants ~

| Amount | Met

©Q0® @2

4% Show Group By Box

I |E| Column Chooser

Best Fit (all columns)
Y Filter Editor...
Show Find Panel

Show Aute Filter Row

5. Drag Tax, Tax Code and Tax Rate out from Column Chooser if the fields are not displayed by default.
Repeat same steps for other transactions.

Details | Multi-Payments |

il | Scan Ttem..

m X v &

| -f_'_"|5t0ck Code |Descri|:m'0n

|aty

.-J

|UO

= @ = [F View Variants =

v

Customization: Cash Sales Details X

|iax

Tax

Tax Class

Tax Class Value

Tax Class Value Ref

Tax Code

Tax Exd.

Tax Exd.L

Add...

Remove
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6. Keyin stock item, quantity, unit price and tax code. Save
$; Cash Sales
Detas | Customerl DO Addressl Others [ Notesl (* Files l Info l JomPay |
Customer - Currency MYR Rate 1.0000
To ' Attention ' | Docpate  [14/10/2021
Term C.0.D. - Agent ~| C.Sales No. |CS00006
rocation -| Deposit To CASH IN HAND -| chequemo. |
Bank Charges (0.00 Reference No. Post To AR Tax Inclusive v|Rounding
Details | Mult-Payments
S ————— = = — =
[J | |Scan Item.. W X ¥ & 9B €O BViewariants- @ @ @ @~ 8
L | ~ | Stock Co‘..isatch No |Description Qty 1UOM |Unrt ... | Tax Code | Tax | Tax Rate  IDisc Net Serial No
RM1 RAW MATERIAL 1 1 UNIT(S) 12.00] ST-10% E 10.00%
y RM2 RAW MATERIAL 2 10 UNIT(S) 5.50{ ST-10% 10.00%
7. View GL Transaction. Notice that system Credit to SST Sales Tax account
i GLTransaction - O X
Date Account # Account Name Doc # | Reference No Description ‘ Debt w |Credt ¥ |From Acc... 4
» 114/10/2021 SST-1000 | sST SALES TAX Jcsoooos CASH IN HAND | .70} 100-0100
14/10/2021 700-0400 CASH IN HAND €S00006 73.70 700-0400
14/10/2021 100-0100 SALES €S00006 CASH IN HAND 67.00 700-0400
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8. Go to SST Sales Tax Return. Click New and OK

File Home Edit Info View Tools Inquiry Maintenance

o' Tax Codes
@ SST Advisor
3% GST/SST Settings
v [ SST Returns
& Sales Tax Retumn
& Service Tax Retum
[ Defauk Priority Settings
@ Tax Code Mapping Wi...

— Taxable Start Date

E9 Dashboard
& General Ledger

& Customer
&# Supplier
¢* Sales

@ Purchases
P Stocks

(] ©® 8 °?f B 0 © - a

Text to search... 2|
New Audt Add/Remove Reset View View Variants Previous Next Record ' Close
v Tral  in Favorites  Settings v Record
Records Creation View Records Navigation Full Text Search Close
Navigation (4 % x [ salesTax Return X
—
esT/ssT ¥ Sales Tax Return

? Have you done the bank recondiliation?

Have you done the bank reconciliation for all of your bank accounts?

Why do you need to p your bank re iliaton?

By reconciled your bank accounts with your bank statement, you can identify unknown payments
from your s 35 ad: d and you can spot the reéturned cheque in earlier
nage.

ancel |

9. Fill up taxable period. Then Save it, so that you do not need to fill the taxable period again later.

After this, click “Re-Generate Draft Data”, system will display the result according to the SST tax codes

as selected

|9 Sales Tax Return

Taxable Period
Taxable Start Date  01/09/2021 ~| Taxable End Date
Due Date 30/11/2021 -

PART BL | PART B2 | PART D | PART E | Event Info |

Sales Detais
1 B Viewvariants> @ @ @ - (2
Document Date Document Code Doc Type
» 14/10/2021 INV00007 smv
14/10/2021 500006 cs N
14/10/2021 500006 cs

Status
31/10/2021 -| - Re-Generate @ Draft
Draft Data
Stock T | Description of Taxab... | Custom Tariff Code Tax Code Value of Tax... | Value of Goo...
RM1 RAW MATERIAL 1 0000.11.9999 ST-10% 12.00
RM1 RAW MATERIAL 1 0000.11.9999 ST-10% 12.00

RM2 RAW MATERIAL 2 0000.22.8888 ST-10% 55.00

DocNo :1 Page No: 11/19
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10. Click Retrieve SST Reports SST-02

nfo View Tools Inquiry Maintenance

H & e B O © © & 182

- |
Save and Save and New  Audit Reset View View Variants Retrieve Previous Next Record Search  Close
Close Trall  Settings v SST Reports v Record
Save View SST-02 cords Navigation Close

¥ Sales Tax Return

11. Notice tax amount at the Taxable Goods at 10% Rate in column 11 (b)
If you defined tax code for ST-5%, system will display the result in column 11 (a)

BAHAGIAN B2 : NILAICUKAI YANG KENADIBAYAR ATAS BARANGAN (JUALAN /PELUPUSAN /
KEGUNAAN SENDIRI)/PERKHIDMATAN (PERKHIDMATAN DIBERIKAN / KEGUNAAN SENDIRI)
PARTB2:VALUE OF TAX PAYABLE FOR GOODS (SALES, DISPOSED, OWN USE)/
SERVICES (SERVICES PERFORMED /OWN USE)

11) Jumiah Nilai Jualan dan Cukai Yang Kena dibayar Mengikut Kadar Cukai.

Total Value of Tax Payable as Per Tax Rate.
Nilai Jualan / Perkhidmatan Bercukai /
Bilangan Kad

Vaiue of Texable Sales/ Service

Kadar Cukai Nilai CukaiKena Bayar
Tax Rate Value of Tax Payable

/No. of Cards
a) Barangan Bercukai Berkadar 5%.
Taxable Goods at 5% Rate. | RM 0.00 I I 5% I | RM 0.00 |
b) Barangan Bercukai Berkadar 10%. -
Taxable Goods at 10% Rate. [RM 79.00| [ 10% | |RM 7.00]
¢) Perkhidmatan Bercukai selain dari Kumpulan H o
Taxable Services other than from Group H. IRM goo I I £= 1 I R O‘OOI
12. Create Sales Credit Notes. Select Tax Code ST-5% for example
59 Sales Credit Notes
Details ‘ Customerl DO Address I Others l Notes I Y Fiesl Info
Customer | 700-A001 -| 1o ADVANCE TRADING SDN BHD Doc Date 14/10/2021
Currency MYR Rate 1.00000000 Exchange Rate Credit Note No. | CN2110/002
Location | - Attention Reference No
Reason - | Agent - Tax Inclusive Rounding
Details | Knockoff
| } Scan Item.. (| XY & By B €O BViewriants @ @ 0 [ - (2
Stock Co... ‘ Description Batch No |F.Desc Qty |UOM Tax unit ... | Tax ... | Tax Code Disc Amo... | Net Serial No
v RM2 RAW MATERIAL 2 @ 1 UNIT(S) ~ 3.00 60.00 5.00% ST-5% | 60.00 63.00

L
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13. View GL Transaction. Notice that system will Debit to SST Sales Tax account
© GLTransaction - m] X
Date Account # Account Name Doc # Reference No Description Debit ¥ |Credit w |From Acc... &
» 114/10/2021 SST-1000 |sST sALES TAX |cn2110/002 ADVANCE TRADING ... | 3.00] 100-0100
14/10/2021 100-0100 SALES CN2110/002 ADVANCE TRADING ... 60.00 700-A001
14/10/2021 700-A001 ADVANCE TRADING ... CN2110/002 SALES RETURNS 63.00 700-A001
N
14. Go to SST Sales Tax Return again, notice that the taxable period already there.
——
|¥j Sales Tax Return
|Taxable Start Date ‘Taxable End Date 55T BadeDebt Only Return and Payment Due Date | Status
b 101092021 31/10/2021 ] 30/11/2021 (2] Draft

Click on “Re-Generate Draft Data” since new transactions has been added. Then click Retrieve SST
Reports SST-02

E & o2 B 0 © © « B8

Save and Save and New  Audit Reset View View Varnts  Retrieve Previous Next Record Search  Close
Close Tral  Settings > SST Reportsv  Record
Save View SST-Q2 cords Navigation Close
Sales Tax Return & TESTINGDB_2021. x i Cash: SST_j}pM g1 -CashS (Y Sales Credit Notes ¥ CN2110/002 - Sal

|¥f Sales Tax Return

Taxable Period Status
Taxable Start Date | 01/09/2021 ~| Taxable End Date |31/10/2021 - { = Re-Generate Y Draft
Draft Data
Due Date 30/11/2021 v
PART B1 | PART B2 | PART D | PART E | Event Info
Sales Details
B BViewveints @ @ [H - (2
Document Date Document Code Doc Type Stock Description of Taxab...| Custom Tariff Code Tax Code Vale of Tax...
» 14/10/2021 v INV00007 SINV [ RM1 [ RAW MATERIAL 1 v 0000.11.9999 . ST-10% ' 12.00
» 14/10/2021 CS00007 cs RM2 RAW MATERIAL 2 0000.22.8888 ST-5% 60.00
14/10/2021 CS00006 cs RM1 RAW MATERIAL 1 0000.11.9999 ST-10% 12.00
14/10/2021 CS00006 cs RM2 RAW MATERIAL 2 0000.22.8888 ST-10% 55.00
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15. Notice tax amount at Tax Deduction from Credit Note in column 13 (a)

BAHAGIAN B2 : NILAI CUKAI YANG KENA DIBAYAR ATAS BARANGAN (JUALAN / PELUPUSAN /
KEGUNAAN SENDIRI) / PERKHIDMATAN (PERKHIDMATAN DIBERIKAN / KEGUNAAN SENDIRI)
PART B2 : VALUE OF TAX PAYABLE FOR GOODS (SALES, DISPOSED, OWN USE) /
SERVICES (SERVICES PERFORMED / OWN USE)
11) Jumiah Nilai Jualan dan Cukai Yanq Kena dibayar Menqikut Kadar Cukai.
Total Value of Tax Payable as Per Tax Rate
Nilai Jualan / Perkhidmatan Sercukai
Siangan Kad ; Kadar Cukai  Niai Cukai Kena Sayar
Value of Taxable Sales / Service Tax Rete Value of Tex Payable
/No. of Cards
a) Baranqan Bercukai Berkadar 5%.
Taxabie Goods at 5% Rate I RM 60.00 l l 5% | I RM 3.00 |
b) Barangan Bercukai Berkadar 10%.
Taxable Goods at 10% Rate I RM 79.00 I [ 10% I RM 7.9 |
c) Perkhidmatan Bercukai selain dan Kumpulan H
Taxabie Services other than from Group H. I RM I\ 0.00 | [ 6% I RM 0.00 I
d) Perkhidmatan Bercukai dan Kumpulan H
Taxabie Services from Group H. I 0 UN”' IRM 25| I RM 0.00 I
12) Jumiah Nilai Cukai Yang Kena Dibayar*
Total Value of Tax Payable.* | Rm 1090 |
(12) =[11(a) + 11(b)] ATAU/OR [11(c)+11(d)]
13) Amaun Potongan cukal
Amount of Tax Deduction
a) Potongan Cukai Melalui Nota Kredit * I RM 3.00 I
Tax Deduction from Credit Note * -
b) Potongan Cukai Jualan *
Sales Tax Deduction * LRm 00|
SUBMIT SST RETURN

This is used to lock the Tax after making payment and complete the transaction at the custom portal

For Submission and Lock Taxable Period, Go to Edit > Submit SST Return

Info View Took Inquiry Maintenance

= & | 4

Resave Unlock Taxabie | Submit SST|
Period Return

Record Edit
7 Sales Tax Return (& TESTINGDB_2021. x

¥ Sales Tax Return

Taxable Period Status
|
Taxable Start Date | B¥(E/PIPA] ~| Taxable End Date |31/10/2021 - - Re-Gfetnemte Y Draft
; : Draft Data
Due Date 30/11/2021

PART B1 |PART B2 | PART D | PART E | Event Info |

Sales Details
= BViewvariants> @ @ [/ - 2
Document Date Document Code Doc Type Stock Description of Taxab... | Custom Tariff Code Tax Code
» |14/10/2021 NV00007 Smy RM1 RAW MATERIAL1  0000.11.9999 ST-10%
14/10/2021 CS00007 cs RM2 RAW MATERIAL 2 0000.22.8888 ST-5%
14/10/2021 CS00006 cs RM1 RAW MATERIAL 1 0000.11.9999 ST-10%
14/10/2021 CS00006 cs RM2 RAW MATERIAL 2 0000.22.8888 ST-10%

Value of Tax...
12.00
60.00
12.00
55.00
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16. Fill up information. Click Submit

2 ™ Ms Lee - SST Return Declaration Info - (m) X

Declaration Date |12/11/2021 -]
Name of Declarant IMs Lee I
Identity Card / Passport No. |8201111-11-1112 |
|
|

' Designation of Declarant | Account Manager
Telephone No.. |8943 0000|

17. Click Yes to confirm. System will generate the Journal Voucher automatically

A Confirmation
; [

Do you want to generate the journal entry for this tax return?

Yes No
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18. Click Yes to open journal
; Success
—
Journal entry has been generated successfully!
Do you want to open the journal?
Yes No

19. System generates a Journal Entry & Posting the double entries

Dr SST Sales Tax
Cr SST Payable Account

|| Journal Entries
Journal
Description - | Doc Date 31/10/2021
Currency MYR - Rate 1.00000000 Journal # 1V2110/002
Project -
Account | 9] Fles| Info
0 X9 & 5 ©cF Oviewvarants- @ @ @ (@ - (2
Account Account Name Description Project Cost Centre Reference/ T... | Debit Credit Company Name | GST Reg. No Creditabl... | Re|
» SST-1000 TAX Being adjustment of SST Payable a... 7.90 Payable
SST-8000 SST P, ACCOUNT Being adjustment of SST Payable a... 7.90 Creditable
20. Status of Sales Tax Return becomes Submitted
==
v/ Sales Tax Return
Taxable Period Status
Taxable Start Date [V[E/PIPAN - Taxable End Date  31/10/2021 - 3 Re-Generate v Submitted
Draft Data
Due Date 30/11/2021 -

PART B1 |PART B2 | PART D | PART E | Event Info

Sales Details N
, = B)Viewveriants @ @ [/ - (2
Document Date Document Code Doc Type Stock Description of Taxab... | Custom Tariff Code Tax Code
v 14/10/2021 INV00007 Sy RM1 'RAWMATERIAL1  0000.11.9999 ST-10%
14/10/2021 CS00007 cs RM2 RAW MATERIAL 2 0000.22.8888 ST-5%
14/10/2021 CS00006 cs RM1 RAW MATERIAL 1 0000.11.9999 ST-10%
14/10/2021 CS00006 cs RM2 RAW MATERIAL 2 0000.22.8888 ST-10%

Value of Tax...
12.00
60.00
12.00
55.00
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21. Open back the transaction within taxable period.

$; Cash Sales

Deﬁ‘ Customer I DO Address I Others I Notes [ @%I Info I Jornpaﬂ

Customer || i~

Currency MYR Rate
i ] | Attention \ I[pocpate  [14/10/2021 |
Tam co.0. - Agent | -| . saleso. |cso0007
tocation | T [CASHINHAND -| ChequeNo. |
Bank Charges ; OE Reference No. [7

| []Ppost To AR

Tax Inclusive

Details | Multi-Payments
O iScan Item..

\!1|x9*0\@j 5 C O BvViewvarants @ @ ® /- 2

j l Stock Co... [ Batch No JDescnotxon Qty uoMm LUnm I Tax Code 1 Tax Tax Rate lesc

» RM2 RAW MATERIAL 2 1] UNIT(S) 60.00 ST-5% 5.00%
N
22. Try Edit from quantity 1 to 2. Save.

$/ Cash Sales
Details ‘ Customer | DO Addressl Others I Notes l ﬂ Files l Info I Jonpaiy]
Customer ( .} Currency MYR Rate
To ] Attention \ | Docpate [14/10/2021
Term [cop. - Agent ] -| c.salesNo. |cs00007
Location | -| Deposit To | CASH IN HAND -| Chequeto. |
Bank Charges |0.00 Reference No. | | ("] Post To AR [] Tax Incusive

Details 'Muh-Payments

(1 | [scan mtem.. W X o B P H GO 0 B ViewVariants-

C|stock co... | Batch no lDescrpoon Qty IUOM

» RM2 RAW MATERIAL 2 2 IUNIT(S) 60.00 ST-5%

@O0®@E- @
|Unrt ...\Taxtode Tax

| Tax Rate | Disc
5.00%
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23. System will not allow saving with a validation error message

«” Validation Error - O X
Problems were detected during data validation. Please read the information below
to understand what the issues are and how you can correct them.

Target 4 | Description
'CS00007" (Cash Sales,  Create/modify tax transaction in submitted taxable period is not
CS00007) allowed. Taxable period: 01/09/2021 - 31/10/2021.
Close
UNLOCK TAXABLE PERIOD

Edit > Unlock Taxable Period. Click Yes

Flle

=

Took  Inquiry Mantenance

x & & B

Delete Refresh Resave JUnlock Taxable
Period

# Tax Codes
gl SST Advsor

Edit Record Edit
Navigation 4 % x (& sales Tax Return x
GST/SST

¥ Sales Tax Return

Taxable Start Date

(3 GST/SST Settings v (02
v [& SST Retums

2 Sales Tax Retumn

& Service Tax Retum
[ Defauk Priority Settings
iy Tax Code Mapping Wi... [

[ Dashboard
&b General Ledger
& Customer

! Unlock Taxable Period

Are yOU SUre YOu want to unlock this taxable period?

N

ind Payment Due Date

021

No

Status

Submtted

24. Enter Reason and Click OK.

|¥ Sales Tax Return

Taxable Start Date

Taxable End Date

| ssTBadepebt only

Return and Payment Due Date

Status

» 101/09/2021

31/10/2021

30/11/2021

Date

« SSTReturn Audit Trail Data Item - (m]

14/10/2021 5:24:28 PM

Reason / Remarks | Amendment for Cash Sales 00001

X

N
[

Cancel

(<]

Draft
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Note: Refer Related Information

QNE Optimum Enabling SST Module | https://www.youtube.com/watch?v=BQ9zeBb7wdw&ab_channel=QNE
%3AAccounting%26PayrollSoftwareMalaysia

QNE Software - SST Sales Tax https://www.youtube.com/watch?v=56JpVwPOxGc&ab channel=QNE
%3AAccounting%26PayrollSoftwareMalaysia

SST TAX CODES MAPPING TO SST-02 | https://support.gne.com.my/support/solutions/articles/81000391877-
FORM sst-tax-codes-mapping-to-sst-02-form



https://www.youtube.com/watch?v=BQ9zeBb7wdw&ab_channel=QNE%3AAccounting%26PayrollSoftwareMalaysia
https://www.youtube.com/watch?v=BQ9zeBb7wdw&ab_channel=QNE%3AAccounting%26PayrollSoftwareMalaysia
https://www.youtube.com/watch?v=56JpVwPOxGc&ab_channel=QNE%3AAccounting%26PayrollSoftwareMalaysia
https://www.youtube.com/watch?v=56JpVwPOxGc&ab_channel=QNE%3AAccounting%26PayrollSoftwareMalaysia
https://support.qne.com.my/support/solutions/articles/81000391877-sst-tax-codes-mapping-to-sst-02-form
https://support.qne.com.my/support/solutions/articles/81000391877-sst-tax-codes-mapping-to-sst-02-form

